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MREL Specialty Explosive Products Limited (MREL) warrants that the product is free from Manufacturer’s defects
for a period of two (2) years from the date of shipment to the Customer.  This Warranty covers all parts and
labour.

MREL does not warrant that the product will meet the Customer's requirements, or that it will operate in the
combinations which may be selected by the Customer.

MREL does not and cannot warrant the performance or results that may be obtained by using the product.
Accordingly, the product and its documentation are sold "as is" without warranty as to their performance,
merchantability or fitness for any particular purpose. The Customer assumes the entire risk as to the results and
performance of the product.

The MREL logo is a registered trademark of Mining Resource Engineering Limited.  The HandiTrap logo is a
registered trademark of MREL Specialty Explosive Products Limited. Windows is a registered trademark of
Microsoft Corporation. Palm is a trademark and PalmOS is a registered trademark of Palm, Inc. Handspring and
Visor are trademarks of Handspring, Inc. All other brand and product names are trademarks or registered
trademarks of their respective companies.

© Copyright 2001, MREL Specialty Explosive Products Limited. This Operations Manual and accompanying
HandiTrap Advanced Analytical Software supersedes any earlier editions. All Rights Reserved. Reproduction or
adaptation of any part of this documentation or Software without written permission of the Copyright owner is
unlawful.
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ABOUT THIS MANUAL
Congratulations on your acquisition of the HandiTrap VOD Recorder, manufactured by MREL Specialty Explosive
Products Limited (MREL). The instructions in this Operations Manual serve as a reference for the operation of the
HandiTrap for recording the continuous velocity of detonation (VOD) of explosives and hole/deck delay times. The
Operations Manual is divided into the following Chapters:

CHAPTER 1: GETTING STARTED
This Chapter assists those new to the operation of the HandiTrap to ensure that:
1. All of the HandiTrap hardware has been received.
2. The HandiTrap Advanced Analytical Software for Windows is installed and that communications is confirmed

between the Operator’s computer and the HandiTrap.
3. The HandiTrap Advanced Analytical Software for the Palm Operating System (PalmOS) is installed and that

communications is confirmed between the Operator’s computer and the Palm device.

CHAPTER 2: INTRODUCTION
This Chapter addresses the general features of the HandiTrap.  It outlines some safety considerations related to
the use of instrumentation in a blasting environment; and describes the main field applications of the HandiTrap
for recording the VODs of explosive samples.

CHAPTER 3: HANDITRAP HARDWARE
This Chapter covers issues related to the various hardware components of the HandiTrap.  It briefly describes the
main features of the HandiTrap’s front panel; provides details on the HandiTrap power source; and outlines
instructions for recharging and long term storage of the HandiTrap. Also included is a description of the VOD
PROBEROD resistance probe available from MREL.  A summary of the technical specifications of the HandiTrap
is also presented.

CHAPTER 4: RECORDING VODS
This Chapter describes issues related to VOD testing of explosives, and introduces the resistance wire technique
for testing small explosive samples. Also presented are safety considerations and the setup procedure for the
HandiTrap in the field.

CHAPTER 5: HANDITRAP SOFTWARE FOR WINDOWS
This Chapter presents the method for retrieving data from the HandiTrap to a computer and selecting a data file
for analysis. All the features and menu functions of the Windows Software required for analysis and presentation
are described. All the features and menu functions of the Windows Software required for analysis and
presentation are described.

CHAPTER 6: EXAMPLES OF WINDOWS DATA ANALYSIS
This Chapter provides a detailed analysis of VOD information, starting with the selection of the data and followed
by its analysis and formatting for presentation. Several examples are discussed.

CHAPTER 7: ANALYSIS ON PALM DEVICES
This Chapter also presents the method for retrieving data from the HandiTrap to a Palm device and selecting a
data file for analysis. All the features and menu functions of the PalmOS Software required for analysis and
presentation are described.

CHAPTER 8: CONTACTING MREL FOR TECHNICAL SUPPORT
This Chapter provides detailed contact information for MREL’s Blasting Instrumentation Team.  It also provides
instructions for emailing HandiTrap files to MREL for complimentary analysis support.
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1.1 ENSURING THAT ALL HANDITRAP HARDWARE HAS BEEN RECEIVED

Details of these hardware components are contained in Section 3.1.
1. HandiTrap VOD Recorder.
2. HandiTrap Battery Charger that is labeled 120 VAC or 220 VAC depending on your Country’s mains power.
3. Communications Cable - serial port cable.
4. BNC Adapter.
5. HandiTrap Advanced Analytical Software on CD-ROM.
6. HandiTrap Operations Manual.
7. VOD resistance probes: PROBERODs.

1.2 INSTALLING THE HANDITRAP ADVANCED ANALYTICAL SOFTWARE

1.2.1 COMPUTER SYSTEM REQUIREMENTS
The HandiTrap Advanced Analytical Software, for Windows ’95, ’98, ME, NT, 2000, and XP has been provided on
a CD-ROM.  The CD-ROM also contains a medium-resolution digital copy of this Operations Manual in Adobe
Acrobat pdf format (HandiTrap Operations Manual Edition 1.pdf).  Additional copies of the Operations Manual
may be printed for your use as required.

The Software operates on any Personal Computer (PC) system with the following minimum specifications:

1. Windows ’95, ’98, ME, NT, 2000, or XP operating system.  The computer hardware required to install these is
sufficient to run the HandiTrap Software smoothly.

2. 25 Mb hard drive space for Software and digital Operations Manual installation.  Each data file will take up
an additional 8k – 64k of space.  It is recommended that 25 Mb of hard drive space be available on the
computer for data and temporary files.

3. CD-ROM drive.  If the computer does not have a CD-ROM drive, a set of floppy disks can be made with
another computer that has a CD-ROM drive.  The installation program on your CD is arranged in files of the
correct size so that they can be copied to floppy disks.  If the computer has Internet access, contact MREL
(Section 8.1) for instructions on downloading the installation Software from MREL’s Internet web site.  You
may also contact MREL to obtain the Software on floppy disks. 

4. Serial port (ie: COM1, COM2, etc).  Recently, “legacy-free” notebook computers have been produced which
have no Serial port.  These require a USB-Serial port adapter, which are easily obtained at any computer
store.  Some computers have no free Serial ports because they are all in use externally (mouse, UPS) or
internally (modem).  USB has been standard on new computers since 1998, so a USB-Serial converter will
allow these to communicate with the HandiTrap.  For older computers, using a converter to connect the
mouse to the PS/2 mouse port will often allow the previous port to be used.

All of the steps detailed in this Chapter should be completed before the Operator goes into the field to
conduct a VOD test:
1. Ensure that all HandiTrap components have been received and are available.
2. Install the HandiTrap Software on the Operator’s computer.
3. Install the HandiTrap PalmOS Software on the Operator’s Palm device (optional).
4. Ensure that the Operator’s computer and HandiTrap are able to communicate with each other.
5. Ensure that the Operator’s Palm device and HandiTrap are able to communicate with each other

(optional).

CHAPTER 1: GETTING STARTED
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1.2.2 PALM OS DEVICE REQUIREMENTS
1. PalmOS 3.1 or higher.
2. A cradle or travel connector that has a serial connector.  Some PalmOS devices (e.g. Handspring) are

supplied only with a USB cradle and require a separate serial cradle.  The serial cradle provided by these
manufacturers will only work with the RS232 port on a computer.  A third party cable made by Delorme
(www.delorme.com) to connect its RS232 port GPS devices to Handspring devices is required. 

1.2.3 INSTALLING THE SOFTWARE ON COMPUTERS RUNNING WINDOWS
To install the HandiTrap Software, start Windows and insert the HandiTrap CD into the CD-ROM drive. Run the
program on the HandiTrap CD called Setup.exe and follow the screen instructions. When the installation is
complete, shut down the computer and re-start it.

1.2.4 INSTALLING THE SOFTWARE ON A PALM OS DEVICE
To install the HandiTrap Software, start the computer which has the
Palm Desktop software installed.  Insert the HandiTrap CD into the
CD-ROM drive. Run the program on the HandiTrap CD called
PalmSetup.exe and follow the screen instructions. When the
installation is complete, attach the Palm device to its cradle and run
HotSync.  The HandiTrap Icon will be shown on the Palm device.

1.3 COMMUNICATING WITH THE HANDITRAP

1.3.1 COMPUTER SERIAL PORT (COM) CONFIGURATIONS
Through the Communications Cable, the Software is used by the
Operator to download the data from the HandiTrap to the computer
after testing is completed. 

Port information for the computer can be viewed by clicking on Control
Panel - System Properties and clicking on "Ports" to view the current
number of serial ports.

http://www.delorme.com/
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1.3.2 TESTING COMMUNICATIONS BETWEEN THE COMPUTER AND THE HANDITRAP
In most cases, communication works at the first attempt or the problems can be solved with some consultation
with MREL, but it is good practice to always ensure that a particular computer will work with the HandiTrap before
taking it into the field.  Conduct the following test to confirm communications: 

1. Turn on the HandiTrap (with nothing connected to its BNC connector) by holding down both the START and
TEST buttons for 1 second.

2. Connect the HandiTrap to the computer device using the Communications Cable.
3. Start the HandiTrap Software (Windows).
4. Press the "Retrieve Data" button in the main screen.  The

Operator will then be presented with the “Enter a new File Name”
screen.

5. The "Comm Port List Box" sets the communications port used to download data from the HandiTrap.  When
the Software is first used, it suggests "com1", but after the first successful download, it will suggest the port
that was most recently used, so the Operator will not have to set it or remember which port to use.  When
testing a new computer for the first time, simply try all available ports and press the Download button. If
successful communication is established, the following message will be displayed. Go to Step 7.
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6. If successful communication is NOT established, the following message will be displayed.

Press OK and test the other Com ports, per Step 5.  If all Com ports result in the above message, then ensure
that the procedures in Sections 1.2 and 1.3.1 have been followed and refer to Section 1.4 for some
suggestions on troubleshooting the HandiTrap communications error.

7. Exit the Software.  
8. Power off the HandiTrap by holding down both the START and TEST buttons for 1 second.

1.3.3 TESTING COMMUNICATIONS BETWEEN THE PALM DEVICE AND THE HANDITRAP
In most cases, communication works at the first attempt or the problems can be solved with some consultation
with MREL, but it is good practice to always ensure that a particular Palm device will work with the HandiTrap
before taking it into the field.  Conduct the following test to confirm communications: 

1. Turn on the HandiTrap (with nothing connected to its BNC connector) by holding down both the START and
TEST buttons for 1 second.

2. Connect the HandiTrap to the Palm device using the Communications Cable.
3. Start the HandiTrap Software (PalmOS) and click on the TEST button.
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If communication cannot be established, the following will appear:

1.4 TROUBLESHOOTING HANDITRAP COMMUNICATIONS ERRORS

If all computer Com ports have been tried without success, the following may help:

1. Often the most direct solution is to use a USB-Serial cable.  This works for "legacy-free" laptops that have no
serial ports and for other computers that have no available serial ports for an unknown reason.  When
installing the software for these, pay careful note to whether you should install the driver software before
attaching the adapter for the first time.

2. There may be software that is "reserving" a Com port for its own use.  Usually, programs that do this are
shown in the bottom right of the Windows screen.  The following shows icons for the Palm HotSync program
and a Un-interruptible Power Supply (UPS) monitor program both of which use a serial (COM) port.

3. To free a reserved port, exit the program that is using it. For example, to exit
the Palm HotSync software, right click over the Palm icon, then choose Exit.
The HotSync software can be restarted again later without having to restart
the computer.

4. Software for a UPS may install a program that uses a serial cable connected to the UPS to detect if power
has gone off, and then save any open files.  If this software is turned off, ensure that it is turned on again after
downloading has finished.  Often it will return after rebooting the computer.

5. Even though there may be 2 serial ports on a computer, if it has an internal modem, it may have reserved one
of the Com ports for itself, so it may be necessary to try the other serial port.  If a computer has an internal
modem and is using a serial mouse, there may be no available serial ports.  For the short term, unplugging
the mouse and plugging the HandiTrap Cable into that serial port may allow downloading. This will require
using "Tab" to move from button to button and "space" to press a button.

6. If the computer will be used frequently to download HandiTrap data, a serial port can be made available by
changing to a PS/2 mouse or using a USB- Serial cable to add a serial port.  A serial to PS/2 converter can be
used to allow the mouse to be plugged into the PS/2 port, if one is available, which will allow its old port to be
used by the HandiTrap, or the Operator can use a USB mouse to free the serial port.
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7. If you are using a PalmOS device, turn “beam receive” off.  (This is not necessary for all PalmOS devices, but
it helps some devices).

8. If you are using a PalmOS device that has been introduced very recently, it may handle serial port
communications in a slightly different way than earlier devices.  If you cannot download data, please check
the MREL website (www.mrel.com) for the latest version of the Software or inform MREL about the particular
PalmOS device.

9. If the above strategies do not work, please contact MREL, as detailed in Section 8.1, for additional technical
support.
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2.1 BACKGROUND

The HandiTrap VOD Recorder is likely the most affordable and easiest to use portable, high-resolution recorder
available for testing samples of explosives. 

The HandiTrap is a portable, 1 channel, high resolution, explosives continuous VOD recorder. The HandiTrap has
proven its reliability under the extreme temperature, weather, dust and rugged conditions that characterize
blasting environments around the world.

The HandiTrap Advanced Analytical Software allows the Operator to analyze VOD traces recorded by the
HandiTrap. The Software is used to retrieve, display, analyze, print and export VOD data. The Software runs
under 32 bit Windows ’95, ’98, ME, NT, 2000, and XP.  This facilitates extremely fast data handling, and the ability
to copy and paste HandiTrap graphs into any word processors and/or spreadsheets running under those
Windows operating systems. 

Additionally, the HandiTrap is provided with Software for the PalmOS so that the Operator can retrieve, display,
and analyze VOD data on a Palm device without the need for a computer.  This is a unique feature of the
HandiTrap.

2.2 SAFETY CONSIDERATIONS

The HandiTrap is an easy and safe instrument to operate. However, one should be aware of the inherent risk
associated with explosive’s handling and familiar with working in blasting environments. For this reason, it is
always recommended that knowledgeable personnel, experienced in handling explosives and familiar with
blasting procedures, operate the HandiTrap when testing explosives. The standard rules of safety used with
explosives should apply when monitoring VODs or other explosive parameters.

When recording VODs, the HandiTrap outputs a low voltage (less than 5 VDC) and an extremely low current (less
than 50 mA) to the VOD PROBEROD within the explosives from the PROBEROD connector on the HandiTrap.
This low excitation signal ensures that the HandiTrap will not prematurely initiate explosives and/or detonators. 

Standard (and common sense) rules apply when it comes to the presence of electrical storms near the testing
area. Due to the inherent hazards associated with blasting during these storms, in addition to the possibility of
electrical interference causing false trigger signals to the HandiTrap, it is recommended to immediately suspend
all blasting activities and evacuate the area. This is standard policy at most blasting operations.

Persons not trained and/or authorized to handle explosives should not attempt to utilize the
HandiTrap for monitoring explosive properties.

CHAPTER 2: INTRODUCTION
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2.3 APPLICATIONS OF THE HANDITRAP

The main applications of the HandiTrap include testing of explosive samples:

• Test the performance of explosives against the quality control standards set by the manufacturers.
• Measure the continuous VOD in any charge diameter under confined or unconfined conditions.
• Determine the critical diameter and critical density of an explosive charge.
• Determine the gap sensitivity of explosives.
• Measure the timing accuracy of detonators.
• Measure the continuous VOD of primers/boosters.
• Determine the minimum booster size for any explosive by measuring run-up velocities.

The HandiTrap is for testing of explosive samples only.  MREL manufactures other VOD recorders used to record
the VODs of explosives samples and explosives in one or more blastholes and the delay times between holes
and decks of explosives. Contact MREL for information on other MREL VOD recorders that are able to test
explosives in blastholes:
• Measure the continuous VOD in any hole diameter, wet or dry holes, and in any type of rock.
• Measure the continuous VOD in multiple holes per blast.
• Determine whether full detonation, low order detonation or failure occurred, and where in the explosive

column it happened.
• Check VODs against manufacturers' specifications in full scale blasting environments.
• Determine the minimum booster size for any explosive by measuring run-up velocities in full scale blasting

environments.
• Measure the timing accuracy of detonators in full scale blasting environments.
• Measure the effects of water, drill cuttings, and rocks, etc. trapped within the explosive mass.
• Determine the length of explosive column to use in decking operations to evaluate the effect of stemming and

drill cutting dilution, water pick-up, etc. on the explosive run-up requirements.
• Determine the correct length and type of stemming material to be used between decks of explosives to

prevent sympathetic detonation or explosive desensitization from occurring.
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3.1 HARDWARE COMPONENTS

The hardware components of the HandiTrap System include the HandiTrap, a Battery Charger, a
Communications Cable and a BNC Adapter. Also included with the HandiTrap System are the Operations
Manual and the HandiTrap Advanced Analytical Software. A brief description of each of the hardware
components is in the following Sections.

3.1.1 HANDITRAP
The HandiTrap contains electronic circuitry and an internal
rechargeable battery within a protective plastic case measuring
approximately 12 x 6.5 x 4 cm (4.75 x 2.5 x 1.5 in.) and weighing
0.3 kg (0.7 lbs.). The protective case prevents damage from
water, sand, snow, dust and similar harsh weather conditions. As
well, the case offers resistance to high temperatures, shocks and
vibrations. The HandiTrap has a convenient belt clip on the back
and the front of the HandiTrap is shown to the right.

Complete instructions for the field operation of the HandiTrap
hardware are provided in Chapter 4.  The main features on the
front panel of the HandiTrap are outlined below:

The TEST and START buttons pressed simultaneously for one
second are used to turn the HandiTrap ON and OFF.  When the
HandiTrap is ON, the START indicator light flashes indicating that
the HandiTrap is in Active mode.

The LOW BAT. indicator light flashes when the HandiTrap’s
internal batteries need recharging.

PROBEROD: BNC connector for the VOD PROBEROD
resistance probe.

With a PROBEROD connected to the HandiTrap and the TEST button is pressed, a steady TEST indicator light
indicates that the PROBEROD electrical circuit is OK. With a PROBEROD connected to the HandiTrap and the
TEST button is pressed, a slowly flashing TEST indicator light indicates that the resistance in the PROBEROD
electrical circuit is too low (such as a short circuit). With a PROBEROD connected to the HandiTrap and the
TEST button is pressed, a slowly flashing TEST indicator light indicates that the resistance in the PROBEROD
electrical circuit is too high (such as an open circuit).

With a PROBEROD connected to the HandiTrap and the PROBEROD electrical circuit testing OK, pressing the
START button, turns the START indicator light on and puts the HandiTrap in Monitoring mode waiting to record
the blast. After the blast, the START indicator light is flashing…indicating that there is VOD data ready to
download to a computer or to a Palm device.

The COM/CHARGE port is used to connect the Communications Cable to the HandiTrap. The other end of the
Communications Cable is connected to either the computer or the Palm device for retrieval of the recorded data
(Sections 5.1 and 7.1). The COM/CHARGE port is also used to connect the Battery Charger to the HandiTrap.

CHAPTER 3: HANDITRAP HARDWARE
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3.1.2 Battery Charger
The Battery Charger has a specification printed on it, either 120 VAC or 220 VAC.  It is used to charge the
HandiTrap’s internal rechargeable battery.

3.1.3 COMMUNICATIONS CABLE 
The Communications Cable is provided to connect the HandiTrap to a computer or to a Palm device for
downloading of the recorded data. The Communications Cable is connected between the COM/CHARGE port
on the front panel of the HandiTrap and the COM serial port of the computer or the Palm device.  The
Communications Cable is a standard “9 pin serial null modem” cable, so should it become misplaced, it can be
replaced easily by the Operator from a local supplier.

3.1.4 BNC ADAPTER
The BNC Adapter is provided to facilitate easy connection between the PROBEROD connector on the HandiTrap
to the coaxial cable (preferably RG-58/U) leading to the VOD PROBEROD resistance probe.

3.2 HANDITRAP INTERNAL RECHARGEABLE BATTERY

The HandiTrap has four internal AA Ni-Cad rechargeable batteries.  The HandiTrap is supplied with an approved
120 VAC or approved 220 VAC Battery Charger, depending on the country of use.  When the internal battery is
fully charged, the HandiTrap can operate for 8 hours (at maximum HandiTrap power consumption) before battery
recharging is required. The HandiTrap is shipped from MREL fully charged.  Since some time may elapse before
the HandiTrap is actually put to use, the HandiTrap may not be charged fully the first time it is used.  Full
operating time will be obtained when the HandiTrap is recharged.  Normal charging time for the batteries is 8 to
10 hours.  Leaving the HandiTrap connected to the charger for longer periods than this can reduce the “charge
lifetime” of the batteries (the number of full charges it can take, normally about 300). The Operator may replace
the HandiTrap’s internal batteries when the battery lifetime starts to decline.  Ensure that NiCad rechargeable
batteries are used, since the voltage used by the charger will not work with other battery types.  Do not operate
the HandiTrap while the charger is connected.  

3.3 RECHARGING THE HANDITRAP

The procedure to recharge the HandiTrap is as follows:
Ensure that the Battery Charger is labeled appropriately for the AC voltage mains power available.
1. With the HandiTrap switched OFF, connect the Battery Charger between the COM/CHARGE port on the

HandiTrap and the wall outlet.

Contact MREL if the Battery Charger that has been
supplied is incorrect for the mains voltage in your
country.

Contact MREL if the Battery Charger that has been supplied is incorrect for the mains
voltage in your country.
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2. Full recharging is obtained after 8 to 10 hours of charging.
3. Unplug the Battery Charger from the wall outlet and then from the HandiTrap.

3.4 LONG TERM STORAGE CONSIDERATIONS

No special procedures, other than those pertaining to the internal batteries, should be taken for long term storage
of the HandiTrap. In the eventuality that the HandiTrap remains idle for long periods, it is recommended to
recharge the HandiTrap once per month per the procedure in Section 3.3.  This will maintain the conditioning of
the internal batteries.  If the batteries lose their ability to hold a charge, replacement AA Ni-Cad batteries are
widely available.

If the HandiTrap batteries run out of power, and there is no time to recharge the HandiTrap batteries, the Operator
can use regular disposable AA batteries as long as the Operator ensures that the Battery Charger is NOT used.

3.5 VOD RESISTANCE PROBE USED BY THE HANDITRAP

The PROBEROD, shown below, is a rigid probe consisting of a high resistance insulated wire placed within a
small diameter, metal tube, which acts as the return lead of the circuit. PROBERODs are specifically designed to
measure VODs of explosive cartridges and/or of short sample tubes of explosives, under confined or unconfined
conditions. They are available from MREL in a standard length of 3 ft. (0.9 m) and are supplied with leads ready
to be connected to the RG-58 coaxial cable, which connects to the PROBEROD connector on the HandiTrap.
Contact MREL for additional PROBEROD information and ordering details.

! The HandiTrap internal battery can not be overcharged. According to the battery
Manufacturer’s specifications, full battery pack recharging will take 8 to 10 hours.  Charging
for extended periods of time can lower the lifetime of batteries, but not damage the HandiTrap
in any way

Do not use the Battery Charger if non-rechargeable (regular) AA batteries have been
installed in the HandiTrap.  The Battery Charger is only for use with rechargeable Ni-Cads.
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3.6 HANDITRAP TECHNICAL SPECIFICATIONS

Number of Channels 1 channel for VOD.
Vertical Resolution 10 bits, 1 part in 1,024.
Recording Rate 1 MHz.
Total Recording Time 1 millisecond (1,024 data points).
Pre-Trigger Time 0.51 milliseconds (512 data points).
Trigger Modes Internally on the VOD signal from the blast.
Power Four internal rechargeable AA NiCad batteries which provide 8 hours of active

operation on a full charge. Full battery recharging is obtained overnight.  The
HandiTrap can also be operated from four AA batteries installed by the Operator.

Components Provided HandiTrap, 120/240 VAC Battery Charger, serial port Communications Cable,
colour Operations Manual, HandiTrap Advanced Analytical Software for Windows,
HandiTrap Software for the PalmTM Operating System.

Size and Weight HandiTrap:  12 x 6.5 x 4 cm (4.7 x 2.6 x 1.6 in.)  0.3 kg (0.7 lbs.).
Environmental Operates at -40 to +80 C (-40 to +185 F). Snow, rain, dust and sand proof. Drop

proof from at least a 1 m (3 ft) height.
PC Connection and
Handheld/PDA
Connection

At any time after recording, the Operator can connect the HandiTrap to a
computer’s (COM) serial port to download and view the VOD data on a computer
within 30 seconds.  For handheld convenience, the Operator can also connect the
HandiTrap to a handheld/PDA device such as a PalmTM handheld or
HandspringTM VisorTM to download and view the VOD data on the handheld/PDA
device within 30 seconds.  (USB PalmOS devices require a conversion cable)

HandiTrap Software for
Windows

The HandiTrap Advanced Analytical Software for Windows operates under
Windows ’95, ’98 and NT. It provides an easy-to-use and familiar graphical-user-
interface that allows the Operator to easily download the data to the computer
and analyze the data.  VOD data are automatically displayed as a graph of
distance versus time.  All Software operations are “point and click”.  The Software
allows unlimited graphical zoom on graphs, creation of annotated sub-graphs and
VOD analyses of any parts of the VOD graph.  Annotating, printing, saving and
export of graphs and data to other Windows software are all easily accomplished.
The Operator can select Metric (m/s) or Imperial (ft./sec.) units.

HandiTrap PalmOS
Software for
Handhelds/PDAs

The HandiTrap Software for the Palm OS® operates on any handheld/PDA
running the Palm OS® Software. It provides an easy-to-use and familiar graphical-
user-interface that allows the Operator to easily download the data to the
handheld/PDA, save the data and analyze the data.  VOD data are automatically
displayed as a graph of distance versus time.  The Software allows unlimited
graphical zoom on graphs and the determination of the VOD between any two
data points on the graph.  Operations are “pen and menu”. Export of data from
the handheld/PDA to a computer running the HandiTrap Software for Windows is
easily accomplished. The Operator can select Metric (m/s) or Imperial (ft./sec.)
units.

VOD Excitation/Safety The HandiTrap’s excitation voltage is pre-set for the maximum 10 bit resolution
across the VOD PROBEROD in the explosives.  All VOD operating parameters
are automatically recorded by the HandiTrap with no requirement for additional
instruments.  The HandiTrap is physically unable to output as much as 50 mA of
current to a VOD PROBEROD.  The HandiTrap does not rely on “current limiting
automatic fault checking systems” which may potentially fail.

VOD PROBERODs 0.9 m (3 ft.) long rigid resistance probes for use in explosive samples with the
HandiTrap.
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CHAPTER 4: RECORDING VODS
This Chapter provides the Operator with detailed instructions on:
1. Selecting a suitable site for testing samples of explosives.
2. Loading the PROBEROD into an explosives sample.
3. Connecting the PROBEROD to the HandiTrap to record the VODs.
.1 SAFETY CONSIDERATIONS FOR SELECTING AN EXPLOSIVE TESTING SITE

are must be taken to select a good site for detonation and VOD recording of explosive samples.  If convenient,
ermanent test sites may be constructed.  A pit surrounded by an earth wall suffices as a simple detonation site.
 similarly protected shelter for the HandiTrap and personnel can be constructed some distance away.  The
istance will depend on the amount of explosive being detonated at one time, and if the explosives are confined
hazard from steel fragments).  Ensure that the area is well demarcated and that access is restricted.

f samples of explosives are to be detonated at an unprepared site, then the Operator must be careful when
eciding upon what type of ground the charges are to be placed. Avoid placement on ground with stones, rubble
r anything that is likely to turn into a projectile.  The best surfaces are fines, sand or tailings.

t is always good practice to have maximum control over the time of firing of the test, therefore safety fuse
nitiation is not recommended. Electric or shock tube initiation is best with the detonator either initiating the sample
f explosives or initiating the primer/booster in the explosive sample.

.2 THE RESISTANCE WIRE TECHNIQUE FOR MEASURING VOD

he HandiTrap is capable of monitoring the continuous VOD profile along the entire length of an explosives
olumn. The HandiTrap can measure the VOD of relatively short explosive samples such as cast boosters or
xplosive cartridges. The HandiTrap provides a regulated constant excitation signal to the PROBEROD and
onitors the drop in voltage across it as the PROBEROD is consumed in the detonation.

he HandiTrap uses the proven continuous resistance wire technique for monitoring VODs. An MREL-
anufactured PROBEROD of known linear resistance (i.e. ohm/m or ohm/ft) is placed axially in the explosive

ample or explosive column. As the detonation front of the explosive consumes the PROBEROD, the resistance
f the circuit will decrease in proportion to the reduction in length of the PROBEROD. The HandiTrap records the
esulting decrease in voltage across the PROBEROD versus time. 

he HandiTrap’s Advanced Analytical Software automatically converts the recorded data into a graph of distance
ersus time. The slope of this graph at any position is the VOD of the explosive at that particular position. The
oftware includes menu functions that will automatically calculate and display the VOD of an explosive at any
elected location in the graph.

Contact MREL for site specific recommendations for testing samples of explosives.
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4.3 INSTALLING THE PROBEROD FOR TESTING A SAMPLE OF EXPLOSIVES

The equipment and supplies that are required to conduct VOD tests on samples of explosives or on explosive
cartridges are:
1. The HandiTrap System.
2. PROBEROD - one (1) per explosive sample.
3. Coaxial cable (type RG-58 is recommended) - sufficient length to run between the HandiTrap location and the

explosives.
4. Wire cutters and electrical tape.
5. Explosives, detonators and shot exploder.

The procedure for preparing a VOD test is as follows:

1. Demarcate the charge detonation area.
2. Place the HandiTrap in a protective shelter and/or a safe distance away from the detonation area. This

distance may be closer than what is considered safe for the Operator. Once the setup is completed, the
HandiTrap does not require an Operator to collect the data; it does so automatically without Operator
assistance.

3. Run a length of coaxial cable from the HandiTrap to the detonation area with enough excess length to
compensate for cable shortening or cable damage from each test. Shorter lengths of coaxial cable may be
connected together using the wire cutters and electrical tape. A male BNC connector should be attached to
the end of the coaxial cable that is to be attached to the PROBEROD input on the HandiTrap. A convenient
BNC Adapter has been supplied with the HandiTrap for this purpose.  The Adapter can be connected to the
coaxial cable using the wire cutters and electrical tape. The connection should be shielding to shielding and
center conductor to center conductor. Ensure that the center conductor and the shielding connections do not
touch each other.

4. Note the Unit Resistance of the probe by reading the value in ohm/m or ohm/ft from the MREL factory label
on the PROBEROD. Note the ohm/m value if the VOD is to be reported in m/s. Note the ohm/ft value if the
VOD is to be reported in ft/sec. The Unit Resistance information will be requested later by the HandiTrap
Software.

5. Insert a PROBEROD axially in the sample of explosives. Start at the opposite end from where the detonator
will be placed as shown below.

If bulk explosives are being tested in paper tubes, plastic tubes or steel pipes which have been sealed at both
ends, make a small central hole to allow the PROBEROD to be inserted. If a measurement of run-up to
detonation is required, ensure that the PROBEROD is pushed well into the explosives so that it reaches the
position of the detonator or booster. If the PROBEROD reaches the booster or protrudes past it, the effect of
the booster will be recorded by the HandiTrap. The same holds true for cartridges of explosives. To test the
VOD of detonation cord, tape the detonation cord along the entire length of the PROBEROD.

6. Connect the PROBEROD to the coaxial cable using the wire cutters and electrical tape. The polarity of the
connection is not important.

Coaxial Cable
To HandiTrap
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7. At the HandiTrap end, connect the coaxial cable to the PROBEROD connector located on the top of the
HandiTrap. 

8. The PROBEROD installation aspects of the test are complete. The Operator can now place the detonator and
connect it to the shot exploder as per standard procedures. The HandiTrap is now ready to be prepared to
record the test as detailed in Section 4.5.

4.4 COAXIAL CABLE PROTECTION

It is important to protect the coaxial cable from damage caused by personnel and machinery operating on the
blast.  It is also important to protect the coaxial cable from damage caused by detonation accessories such as
detonating cord, detonating relays, and shock tube bunch blocks.

The coaxial cable may be protected in many ways.  Experience has shown that it is best to lead the coaxial cable
under the detonating cord, detonating relays and shock tube bunch blocks and leave a barrier of sand or drill
cuttings between the cable and the detonating cord. A good procedure is to protect the area where there is a
cross over for about 1.5 m (5 ft) along the length of cable.  Experience has shown that a sand or stemming barrier
thickness of 15-30 cm (0.5-1 ft) suffices to protect the cable.

It is also a very good idea to lay the sample of explosives down on the ground as opposed to leaving it protruding
vertically from the ground.  This is relevant when testing cardboard or steel tubes filled with explosives.  Please
contact MREL for site and product specific recommendations.

4.5 HANDITRAP SETUP PROCEDURE FOR VOD MEASUREMENT

Once the PROBEROD has been placed in the explosive and connected to
the RG-58 coaxial cable running to the PROBEROD connector on the
HandiTrap, the Operator can start setting the HandiTrap to record VOD
experiments. 

The procedure to record a new VOD test consists of the following steps:

1. Ensure that the coaxial cable coming from the PROBEROD is connected
to the HandiTrap input connector labeled PROBEROD.

2. Turn the HandiTrap power ON by simultaneously pressing the TEST and
START buttons for 1 second. The START light will illuminate and begin
to flash slowly indicating that the HandiTrap is in Stand-by mode.

3. If the TEST light flashes when no buttons are pressed, the battery needs
to be recharged.   

4. Press the TEST button; the TEST light will become illuminated steadily if
the PROBEROD electrical circuit is found to be within the correct
resistance range.  If the TEST light flashes slowly or flashes quickly when
the TEST button is pressed, then there is a problem with the
PROBEROD electrical circuit (PROBEROD, coaxial cable and/or the
BNC Adapter) and the Operator is referred to Section 4.6 for possible
solutions. It is worth noting that the START button will be blocked and the
HandiTrap will be unable to record VODs when the PROBEROD
electrical circuit is found to be out of the correct resistance range.

5. Press the START button. The START light will illuminate steadily. The
HandiTrap then starts monitoring the blast, waiting to start collecting
VOD data when the explosive is detonated causing the HandiTrap trigger signal. Personnel can now vacate
the HandiTrap location.
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6. When the triggering condition is met (i.e. a sufficient length of PROBEROD has been consumed by the
detonation), the HandiTrap will trigger and start collecting VOD information.

7. Once data collection has been completed, the START light flashes slowly at the same rate as when the
HandiTrap was first turned on, but pressing the START or TEST buttons by themselves will have no effect.
Do not switch the HandiTrap OFF at this point.

8. The VOD data is ready to be transferred to a computer or a Palm device using the Software as detailed in
Sections 5.1 and 7.1.  Do not switch OFF the HandiTrap until the data has been transferred.  The HandiTrap
has a volatile memory, so switching OFF the HandiTrap will erase all data.  The BNC Adapter can be
disconnected from the HandiTrap.

9. Once data transfer is complete then the HandiTrap can be switched OFF by simultaneously pressing the
TEST and START buttons for 1 second.

4.6 PROBEROD CIRCUIT RESISTANCE OUT OF RANGE

With a PROBEROD connected to the HandiTrap and the TEST button is pressed, a steady TEST indicator light
indicates that the PROBEROD electrical circuit is OK. With a PROBEROD connected to the HandiTrap and the
TEST button is pressed, a slowly flashing TEST indicator light indicates that the resistance in the PROBEROD
electrical circuit is too low (such as a short circuit). With a PROBEROD connected to the HandiTrap and the
TEST button is pressed, a quickly flashing TEST indicator light indicates that the resistance in the PROBEROD
electrical circuit is too high (such as an open circuit).

The HandiTrap is only calibrated to perform VOD tests between the two initial resistance values (290 - 360 ohms).

There can be several reasons for total resistance to be LOW:

1. A short circuit somewhere in the coaxial cable and probe assembly, including any BNC connector(s) or BNC
Adapter;

2. A damaged PROBEROD

Items 1 and 2 above can be tested using a blaster’s galvanometer to test the resistance/continuity of the coaxial
cable and PROBEROD assembly and solved by remaking the connections and/or replacing the damaged
PROBEROD.

There can be several reasons for the total resistance to be HIGH:

1. An open circuit somewhere in the coaxial cable and probe assembly, including any BNC connector(s) or BNC
Adapter;

2. A damaged PROBEROD

Items 1 and 2 above can be tested using a blaster’s galvanometer to test the resistance/continuity of the coaxial
cable and probe assembly and solved by remaking the connections and/or replacing the damaged PROBEROD.
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5.1 RETRIEVING DATA FROM THE HANDITRAP

The procedure to retrieve data from the HandiTrap to a computer is as follows:

1. Connect the Communications Cable supplied with the
HandiTrap between the Serial Port on the computer and the
LPT COM port on the front panel of the HandiTrap.

2. Turn the HandiTrap power ON.
3. Start the HandiTrap Software by clicking on Start-Programs-

HandiTrap 1.1
4. At the Main Menu click on the Retrieve Data button or with the

keyboard press Alt-R.  Data retrieval can be accomplished
without the use of a computer mouse by pressing “tab” to move
between data entry fields.

5. Choose a drive, directory and file name in which the
HandiTrap data will be stored. The directory defaults to
C:\HandiTrap\Data. The file name, in this case, is
2001Apr018, which indicates the 18th time data has been
downloaded from the HandiTrap in April of 2001. The
Operator can rename the file anything he wishes.  Other
HandiTrap files already stored in the directory are also
displayed. Note that new directories can be created from this
window using the Create New Directory button. As well, that
the current directory can be Set as Default Start Directory
for saving files. When all information is entered, click on the
Download button.  Otherwise, click on the Cancel button to
return to the Main Menu.  If the Download button is pressed
and communication is established, the “% complete” will be
shown until it reaches 100%.   

Ensure that Chapter 1 has been successfully completed prior to beginning Chapter 5.

CHAPTER 5: HANDITRAP SOFTWARE FOR WINDOWS
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6. After the data has been downloaded, the Communications Cable can be detached from the computer and
the HandiTrap and the Operator can proceed to analyze the data.

5.2 SELECTING DATA FILES FOR ANALYSIS

The procedure to select a HandiTrap file for analysis is as follows:

1. If the HandiTrap Software is not running, start the HandiTrap
Software by clicking on Start-Programs-HandiTrap 1.1.

2. At the Main Menu click on the Analyze Data button or with the
keyboard press Alt-A.

3. Click on the file name of interest. Use the File Comments box
as a guide to each file’s content. 

4. Click on the Open button when a file has been selected,
otherwise click on the Cancel button to return to the Main
Menu. Note that the current directory can be set as the default
directory for opening files.

For this example, DetCord is chosen to illustrate the results of a
VOD test on a sample of detonating cord. DetCord and Anfo are
data files that have been included as examples with the HandiTrap
Software. Chapter 6 provides the detailed procedures for
analyzing the data in both of these files.

Clicking on the Open button automatically starts the HandiTrap
Advanced Analytical Software with the chosen data file. The
following Section outlines the capabilities of the Analytical
Software.
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5.3 INTRODUCTION TO ANALYSIS

 The following screen is displayed when a VOD file has been chosen for analysis and all of the sub-graphs
previously saved with the file are opened: 

The screen contains three main areas that are summarized below, and are discussed in more detail in the
following Sections as well as in Chapter 6:
Desktop: the area having the MREL logo as background.  One or more graphs can be displayed in maximized,
normalized or minimized size states in the area.
Tools Bar: a moveable menu of icons, which allows the Operator to access analysis and graphics tools.
Menu Bar: located across the top of the screen.  It includes pull down menus for File, Graph, Edit, Analyze,
Window and Help.

5.4 DESKTOP

When a data file is initially opened, the Desktop area of the Software, which has as a background the MREL
logo, shows the Original Data graph in a minimized state. The data and graphics on the original graphs can not
be changed.  New graph names must be given to the modified graphs (or sub-graphs).  In this way, the original
data for the test can never be lost.  In the example in Section 5.3, the DetCord data file at this point in the
analysis has only 1 graph, which is the Original Data graph.
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From this Original Data graph, other sub-graphs can be made and saved by the Operator under new graph
names.  These sub-graphs can include some or all of the data in the original graph and can include graphics, text
and analysis information as added by the Operator.  The next time the data file is chosen for analysis, the original
graph and all sub-graphs will be opened.  There is no limit to the number of sub-graphs that can be created from
an Original Data graph. The procedure for creating sub-graphs is discussed in Chapter 6.

By clicking on either the normalize icon or on the maximize icon on any minimized graphs (per normal Windows
procedures) the data can be viewed and analyzed.

5.5 TOOLS BAR

The Tools Bar contains a selection of ten (10) tool buttons used to add or modify the graph’s
characteristics, text and graphics and to apply analysis procedures to the data in the graphs to
calculate VODs and delay times between holes.  The Tools Bar can be moved anywhere on
the Desktop.  The basic functions of each of the tool buttons are outlined below:

The Select Tool has many functions including: selecting, moving, minimizing,
maximizing and normalizing graphs; selecting and modifying any component of the
graphs by double clicking on the component (i.e. x-axis, y-axis, data, text, titles).

The Text Tool allows the Operator to add new text/titles/comments to graphs.

The Zoom In Tool allows the Operator to zoom in on any part of the data and graph.

The Zoom Out Tool restores the data to the previous range before a zooming in operation was
performed.

The Data Value Tool displays the digital x, y (time, distance) value of any data point on the graph.

The Line Tool allows the Operator to add a straight line to graphs.

The Arrow Tool allows the Operator to add a straight arrowhead line/pointer to graphs.

The VOD Tool allows the Operator to automatically calculate the VOD for any part of the VOD graph by
doing a linear regression on all of the data between any two data points on the graph.

 
The Delay Tool allows the Operator to automatically calculate the delay time between any two data
points on the graph.

The Print Tool allows the Operator to print the active graph.
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5.6 MENU BAR

The Menu Bar contains a selection of six (6) pull down menus used to open data files and their associated
graphs, save sub-graphs, print graphs, export data and graphics, move and erase bad data points, arrange
graphs on the Desktop and provide access to the digital HandiTrap Operations Manual.  The Menu Bar is always
located at the top of the Desktop.  The basic functions of each of the pull down menus are outlined below:

The File menu allows the Operator to Open data files, display the name of the Current data file, Save the current
data file including the associated graphs and Exit the Analysis section of the Software. 

The Graph menu allows the Operator to List the graphs associated with the current data file, Save and Rename
the sub-graphs, Delete the sub-graphs, Close the sub-graphs for the current analysis session, and Print the
active graph. 

The Edit menu allows the Operator to Change the Axes of the graph and Copy the Graph to the computer’s
memory for pasting into other Windows applications such as word-processors.  Additionally the Operator can
Copy the X Data and Copy the Y Data, which comprises the graph, for subsequent pasting into Windows
spreadsheets. 
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The Analyze menu allows the Operator to Zoom in on the graph, Undo the last Zoom, Reset the graph to full
range, Remove bad data points, Move bad data points, calculate a VOD using Linear Regression, calculate a
VOD from 2 Points on the graph, Remove Negative Distance Changes on a graph, calculate a Y value
Difference and calculate a time Delay. 

The Remove and Remove Negative Distances Changes menu items can be used on data points that
sometimes result from inefficient shorting of the PROBEROD, causing downward spikes in the data.

For example, when explosives
react very slowly, there may be
inefficient shorting of the probe.
This may result in a graph similar to
that shown which is a VOD record
from a MiniTrapII Explosives
Continuous VOD Recorder on
explosives in a blasthole.  The
trend of the VOD is apparent,
however there are many downward
spikes on the trace; this makes the
normal Calculate VOD using the
Linear Regression inaccurate.  In
such cases the Operator can
Calculate VOD From 2 Points
from the Analyze menu.

The Remove Negative Distance
Changes item allows the Operator
to improve the appearance of the
graph for presentation purposes in
an automated fashion. 
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The Window menu allows the Operator to automatically arrange the non-minimized graphs on the Desktop in
three (3) ways: Cascade, tile Vertically, and tile Horizontally.  This menu also allows the Operator to
automatically Arrange the minimized graph icons.

The Help menu allows the Operator to access the Adobe Acrobat format of this HandiTrap Operations Manual on
his computer.  The Operator must have Adobe Acrobat Reader Software to read and print the Operations
Manual.  The Adobe Acrobat Reader Software is available free of charge from the Adobe Internet web site at
www.adobe.com. The Help menu also displays information About the HandiTrap Software, including contact
information for MREL.

http://www.adobe.com/
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6.1 SAMPLE OF EXPLOSIVES – DETONATING CORD EXAMPLE

This Section presents a detailed analysis of a VOD test performed on a sample of detonating cord using a
PROBEROD.  The Operator is encouraged to follow the example using the HandiTrap Software. 

As outlined in Section 4.3, a typical VOD test of an explosive sample is shown below. 

In the following example, the explosive sample is a length of detonating cord that has been taped along the length
of a PROBEROD.

The procedure to select a HandiTrap file for analysis is as follows:

1. From the Main Menu click on the Analyze Data button or with
the keyboard press Alt-A.

2. Click on the file name DetCord. 

3. Click on the Open button, which automatically starts the
HandiTrap Advanced Analytical Software.

CHAPTER 6: EXAMPLES OF WINDOWS DATA ANALYSIS

Coaxial Cable
To HandiTrap
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The following window will be shown after all the graphs in the file have been loaded.  Click on OK or press Enter.

Maximizing the Original Data graph, and moving the Tools Bar, results in the screen shown below: 

The graph shows a line plot of distance versus time for the complete duration of a VOD test. The length of the
detonating cord and PROBEROD is approximately 0.9 m.  

The graph has two time areas: before time = 0 (pre-trigger time) and after time = 0 (post-trigger time).  In all VOD
tests, the HandiTrap is triggered to begin recording at time = 0 but has a pre-trigger data memory before time = 0.
This allows the HandiTrap to record the information from the PROBEROD as it is being consumed to the
PROBEROD length at which the HandiTrap will trigger.  The HandiTrap records post-trigger data after time = 0.
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Using the Zoom In Tool (Section 5.5), the Operator can focus on the area of interest: the part of the graph that
shows the explosive detonating.

The following screen shows results from zooming in on the data of interest.  If the wrong area is chosen, use the
Zoom Out Tool to undo the previous Zoom In. 
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To analyze the data for VOD, choose the VOD Tool (Section 5.5).  The Software calculates the VOD by
conducting a linear regression on the data contained between two data points chosen by the Operator.  The
Software prompts the Operator to click on the “first” data point and then on the “second” data point, thus defining
a data range for the VOD calculation.  The Operator will know when he/she is on a data point as the arrow will
change to a hand. The VOD result is automatically shown with a colored straight VOD line over the data range of
interest.  The Operator can perform an unlimited number of VOD analyses on a graph.  The VOD text can be
chosen with the Select Tool for moving.  By double clicking on the VOD text and VOD line with the Select Tool,
the Operator can change the properties of these items or delete them.

The Text Tool (Section 5.5) can be used to add additional comments on the graph. When the graph has been
annotated to the satisfaction of the Operator, the graph can be saved as a sub-graph.  The Operator cannot
overwrite the Original Data graph that contains the original data and graphics.  The Operator chooses Graph-
Save As and then types in a name for the sub-graph.  This sub-graph will be stored with the Example file and will
be automatically opened along with the Original Data graph the next time the Example file is chosen for analysis.

The Operator may wish to copy the graph into a Windows word-processor for a report.  To do this the Operator
chooses Edit-Copy Graph from the Menu Bar.  The Operator can then minimize the HandiTrap Software, open
the word-processor and Paste the graph.

To print directly from the HandiTrap Software, the Operator can either use the Print Tool or select Graph-Print
from the Menu Bar.
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To change the format of the graph, the x and y-axis, plot type etc… use the Select Tool (Section 5.5) to double
click on the graph window.  Double clicking with this tool on the graph window, axis titles and other objects allows
some changes to be made to the attributes of these items. In the screen below, the Select Tool was used to
double click on the graph window.  The following window is displayed. Under the Plot tab, the property of the
graph was changed to display data points only.



Page 6-6     Operations Manual – Edition 1.0

On the next screen, for interest only, the graph with the VOD analysis has been enlarged further using the Zoom
In Tool.  The Data Value Tool (Section 5.5) has been used to click on the graph to find the distance at which
time = 0.  The x, y (time, distance) coordinates of this point are shown in the Current Point Window. Notice that
when the Data Value Tool is chosen, an arrow appears and in the upper left corner of the graph, the position of
the arrow on the graph window is displayed (x, y).  When the arrow is placed over the graph line, the arrow
changes to a hand.  When the Operator clicks on the graph line then the Current Point Window displays the
value of the data point on the graph line. Note: the arrow and hand cursors are not shown on the screen below.

The Operator is encouraged to experiment with analyzing, formatting and printing the data and graphs contained
in the Example file.  Note: changes are made to the data in the sub-graphs; the Original Data graph cannot be
changed and will always be available for subsequent analyses.



                                                                              Operations Manual - Edition 1.0 Page 6-7

6.2 SAMPLE OF EXPLOSIVES – AN/FO EXAMPLE

This Section presents a detailed analysis of a VOD test performed on a sample of AN/FO using a PROBEROD.
The Operator is encouraged to follow the example using the HandiTrap Software. 

In the following example, the PROBEROD has been inserted into a sample of AN/FO.

The procedure to select a HandiTrap file for analysis is as follows:

1. From the Main Menu click on the Analyze Data button or with
the keyboard press Alt-A.

2. Click on the file name Anfo. 

3. Click on the Open button, which automatically starts the
HandiTrap Advanced Analytical Software.

The following window will be shown after all the
graphs in the file have been loaded.  Click on OK
or press Enter.
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Maximizing the Original Data graph, and moving the Tools Bar, results in the screen shown below: 

The graph shows a line plot of distance versus time for the complete duration of a VOD test. The length of the
detonating cord and PROBEROD is approximately 0.9 m.  

The graph has two time areas: before time = 0 (pre-trigger time) and after time = 0 (post-trigger time).  In all VOD
tests, the HandiTrap is triggered to begin recording at time = 0 but has a pre-trigger data memory before time = 0.
This allows the HandiTrap to record the information from the PROBEROD as it is being consumed to the
PROBEROD length at which the HandiTrap will trigger.  The HandiTrap records post-trigger data after time = 0.
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Using the Zoom In Tool (Section 5.5), the Operator can focus on the area of interest: the part of the graph that
shows the explosive detonating.

The following screen shows results from zooming in on the data of interest.  If the wrong area is chosen, use the
Zoom Out Tool to undo the previous Zoom In. 

Notice that there are some downwards pointing spikes in the data.  When explosives react very slowly, or if the
explosive is of relatively low energy, there may be inefficient shorting of the probe. This may result in a graph
similar to that shown.  The trend of the VOD is apparent, however there are many downward spikes on the trace;
this makes the normal Calculate VOD using the Linear Regression inaccurate.  In such cases the Operator can
Calculate VOD From 2 Points from the Analyze menu. To analyze the “noisy” data for VOD, choose the
Calculate VOD From 2 Points from the Analyze menu.  The Software calculates the VOD by drawing a straight
line between two data points chosen by the Operator, and displaying the slope of the line.  The Software prompts
the Operator to click on the “first” data point and then on the “second” data point, thus defining a data range for
the VOD calculation.  The Operator will know when he/she is on a data point as the arrow will change to a hand.
The VOD result is automatically shown with a colored straight VOD line over the data range of interest.  The
Operator can perform an unlimited number of VOD analyses on a graph.  The VOD text can be chosen with the
Select Tool for moving.  By double clicking on the VOD text and VOD line with the Select Tool, the Operator can
change the properties of these items or delete them.
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The Text Tool (Section 5.5) can be used to add additional comments on the graph. When the graph has been
annotated to the satisfaction of the Operator, the graph can be saved as a sub-graph.  The Operator cannot
overwrite the Original Data graph that contains the original data and graphics.  The Operator chooses Graph-
Save As and then types in a name for the sub-graph.  This sub-graph will be stored with the Example file and will
be automatically opened along with the Original Data graph the next time the Example file is chosen for analysis.

The Operator may wish to copy the graph into a Windows word-processor for a report.  To do this the Operator
chooses Edit-Copy Graph from the Menu Bar.  The Operator can then minimize the HandiTrap Software, open
the word-processor and Paste the graph.

To print directly from the HandiTrap Software, the Operator can either use the Print Tool or select Graph-Print
from the Menu Bar.
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6.3 SAMPLE OF EXPLOSIVES – OTHER EXAMPLES

The following examples are provided as an illustration of the VOD analysis capabilities of the HandiTrap.

This result is typical for an explosive failing to detonate completely.

This result illustrates the effect of confining the explosive in Schedule 40 steel pipe (a standard substitute for
rock). The explosive detonates fully when loaded in steel pipe but fails when unconfined as shown in the previous
graph.
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The following is the result of a VOD test on unconfined bulk explosive. It can be observed that a second booster
was placed in the explosive column that had not been tied into the shot exploder. As can be seen, the Operator
can determine the VOD anywhere along the 0.9 m long unconfined sample.
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7.1 RETRIEVING DATA FROM THE HANDITRAP

The procedure to retrieve data from the HandiTrap to a Palm device is as follows:

1. Place the PalmOS device in its cradle (or attach the Travel HotSync cable).
2. Connect the Communications Cable supplied with the HandiTrap between the

Palm device and the LPT COM port on the front panel of the HandiTrap.
3. Turn the HandiTrap power ON.
4. Start the HandiTrap Software on the Palm device.
5. Tap the Download button.

6. The Download Window will appear. The naming
convention for the data files is the default of “VOD_”
followed by a number to create a unique name.  This
can be changed by using Menu-About-
Preferences.  The Operator can also create a new
name each time data is downloaded by editing the
Data Set name.

7. In this example, using Menu-About-Preferences
the Operator changes the default name of Data Sets
from VOD to NewUser, which would be followed
automatically by a number.

8. Also from the Preferences Window, the Operator
can choose measurement units of metres (for VOD
in m/s) or feet (for VOD in ft/s). Also the Operator
can choose one of two method for conducting VOD
analysis 1 Button VOD or 2 Button VOD, these are
discussed in Section 7.2. 

CHAPTER 7: ANALYSIS ON PALM DEVICES
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9. Tapping the Save Button returns the Operator to the Download Window. The
Software automatically creates an initial comment from the date and time and,
optionally, the Operator can add comments that are useful to describe the
contents of the file when opening files for analysis.

10. When comments have been entered the Operator
can tap on the Start Button to begin downloading
data from the HandiTrap. The progress of the
data transfer is shown as % Complete.

7.2 ANALYSIS

1. When downloading has finished, tap the Analyze button.  The Software will
display a list of downloaded data sets.  Tapping on a name will make it the
current data set and show the comments
associated with it.   Tap the Open button to view
the current data set.  You can also Beam or
delete a data set from this window.

2. When a data set is opened the data will be graphed as shown.  The graph has
displays time in ms on the x-axis and length in metres or feet on the y-axis.

3. The Operator may tap inside the graph area to
display the exact value of the nearest data point
on the VOD graph.  The (time, length) value is
displayed in the lower left corner. Pressing the
scroll up/down button on the Palm device views
the next/previous data point value.
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4. To view the data from the detonation event more closely, tap on the Zoom
button (Z+) then create a zooming rectangle by tapping at one corner of the
area of interest and sliding the pen to create a “zoom rectangle”. When you lift
the pen, the graph will be zoomed to that area.

5. To calculate a VOD, tap the VOD button, then the next 2 points selected will
determine the start and end points of the VOD.  (For noisier graphs, it may be
necessary to choose the points more precisely with the 2 Button VOD mode)
After choosing 2 points, the VOD is calculated and looks as shown. Note that
the VOD calculation is based on a straight line drawn between the two points
chosen by the Operator.  A linear regression on the data is not performed.  For
calculation of a VOD using linear regression, the Operator should use the VOD
tool in the Windows Software as detailed in Section 5.5.

6. At this point, the Operator can tap the Unzoom
button (Z-) to return to the previous view, and
calculate another VOD.  There are 10 levels of
Unzoom stored.  Also, there are Menu functions to
Redraw the current graph without the VOD line
and text.  Choosing Full Range will unzoom back
to the original graph.  Show in feet or Show In
metres will redraw the graph with those units.

7. Some explosives, such as ANFO, can sometimes result in noisy traces but still
show a clear VOD trend.  With a small resolution PalmOS device, it can be
difficult to tap the exact point desired, and because of noise, the next point may
have a very different value.  The 2 Button VOD mode (set in Section 7.1)
allows the Operator to tap on the graph (or use the scroll button) as many times
as needed to get the desired 1st VOD point.   The
V1 button is then tapped.  Next, the location for the
2nd point of the VOD is chosen, then the V2 button
is tapped, and the VOD is shown.
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8.1 CONTACTING MREL

MREL Specialty Explosive Products Limited
Blasting Instrumentation Team
1555 Sydenham Road
Kingston, Ontario K7L 4V4
Canada
Toll Free Canada/USA: 1-877-544-MREL
Tel: +1-613-545-0466    Fax: +1-613-542-8029
Email: VOD@mrel.com
Web site: www.mrel.com 

8.2 EMAILING HANDITRAP FILES TO MREL

It is an easy procedure to send a HandiTrap file for its analysis/review by another Operator who also has the
HandiTrap Software.

When a file is saved on a computer, the file name takes the form of filename.filetype, otherwise known as
root.extension.  When a HandiTrap file is saved using a name chosen by the Operator (for example: test), several
files with different filetypes are automatically created by the HandiTrap Software all with the same filename, test.

To email a HandiTrap file called "Example", attach the entire HandiTrap files with the same filename, to the email.
It is better if all of the files are contained in one ZIP file for transfer by email, particularly if the HandiTrap data
were not compressed when downloaded to your computer.  Normally MREL only requires the *.htp and *.raw files
to conduct an analysis.  If you want MREL to review the sub-graphs you have saved containing VOD analyses
you have performed on the original data, then all of the files below will be required.

For example:

Example.htp (the HandiTrap settings file, which is a readable text file).  MREL requires this file.

Example.raw (the HandiTrap data file).  MREL requires this file.

Example.plot001, Example.plot002 etc… (the series of sub-graph files the Operator saved during analysis)

Example.r01 (the data points removed from a sub-graph by the Operator)

Example.ml001  (the series of x values of data points moved in a sub-graph by the Operator)

Example.mv.001 (the series of new y values of data points moved in a sub-graph by the Operator) 

As part of MREL’s ongoing commitment to Customer Satisfaction, MREL VOD Specialists will be pleased to
review your analysis of your HandiTrap data.  If you would like to have a “second opinion” from MREL on your
analysis of a specific test, send an email to VOD@mrel.com with a brief description of the test and attach all of
the files.

MREL looks forward to providing you with assistance.

CHAPTER 8: CONTACTING MREL FOR TECHNICAL SUPPORT
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